AutoCAD® 2011 Tutorial
Second Level: 3D Modeling

Randy H. Shih
Oregon Institute of Technology

www.SDCpublications.com
Schroff Development Corporation
# Table of Contents

**Preface**
**Acknowledgments**

## Chapter 1
**Getting Started**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>1-2</td>
</tr>
<tr>
<td>Development of Computer Geometric Modeling</td>
<td>1-2</td>
</tr>
<tr>
<td>Why Use AutoCAD® 2011</td>
<td>1-5</td>
</tr>
<tr>
<td>Getting Started with AutoCAD® 2011</td>
<td>1-7</td>
</tr>
<tr>
<td>AutoCAD® 2011 Screen Layout</td>
<td>1-8</td>
</tr>
<tr>
<td>Application Menu</td>
<td>1-9</td>
</tr>
<tr>
<td>Quick Access Toolbar</td>
<td>1-9</td>
</tr>
<tr>
<td>AutoCAD Menu Bar</td>
<td>1-9</td>
</tr>
<tr>
<td>Graphics Cursor or Crosshairs</td>
<td>1-9</td>
</tr>
<tr>
<td>Command prompt Area</td>
<td>1-9</td>
</tr>
<tr>
<td>Cursor Coordinates</td>
<td>1-10</td>
</tr>
<tr>
<td>Status Toolbar</td>
<td>1-10</td>
</tr>
<tr>
<td>Ribbon Tabs and Panels</td>
<td>1-10</td>
</tr>
<tr>
<td>Draw and Modify Toolbar Panel</td>
<td>1-10</td>
</tr>
<tr>
<td>Layers Control Toolbar Panel</td>
<td>1-11</td>
</tr>
<tr>
<td>Annotation Toolbar Panel</td>
<td>1-11</td>
</tr>
<tr>
<td>Layout/Model Toolbar</td>
<td>1-11</td>
</tr>
<tr>
<td>Viewing Toolbar</td>
<td>1-11</td>
</tr>
<tr>
<td>Workspace Switching</td>
<td>1-11</td>
</tr>
<tr>
<td>Mouse Buttons</td>
<td>1-12</td>
</tr>
<tr>
<td>[Esc] - Canceling commands</td>
<td>1-12</td>
</tr>
<tr>
<td>On-Line Help</td>
<td>1-13</td>
</tr>
<tr>
<td>Leaving AutoCAD® 2011</td>
<td>1-14</td>
</tr>
<tr>
<td>Creating a CAD File Folder</td>
<td>1-15</td>
</tr>
</tbody>
</table>

## Chapter 2
**User Coordinate System and the Z-Axis**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>2-2</td>
</tr>
<tr>
<td>The Floor Plan Design</td>
<td>2-2</td>
</tr>
<tr>
<td>Starting Up AutoCAD® 2011</td>
<td>2-3</td>
</tr>
<tr>
<td>3D Modeling WorkSpace</td>
<td>2-4</td>
</tr>
<tr>
<td>Drawing Units Setup</td>
<td>2-5</td>
</tr>
<tr>
<td>Drawing Area Setup</td>
<td>2-6</td>
</tr>
<tr>
<td>GRID and SNAP Intervals Setup</td>
<td>2-7</td>
</tr>
<tr>
<td>Drawing Polylines</td>
<td>2-9</td>
</tr>
<tr>
<td>Creating an Offset Polyline</td>
<td>2-10</td>
</tr>
<tr>
<td>Creating Interior Walls</td>
<td>2-11</td>
</tr>
<tr>
<td>Completing the Doorway Using the TRIM Command</td>
<td>2-14</td>
</tr>
</tbody>
</table>
User Coordinate System – It is an XY CRT, but an XYZ World 2-16
Viewing the 2D Design in 3D Space 2-17
Adding the 3rd Dimension to the Floor Plan Design 2-18
Viewing the Design Using the Hide Option 2-20
Adding New Layers 2-21
Moving Entities to a Different Layer 2-23
Moving the UCS 2-23
Creating the Roof 2-25
Rotating the UCS 2-27
Sketching on the Rotated UCS 2-28
Viewing the Design Using the Hidden Option 2-29
Questions 2-30
Exercises 2-31

Chapter 3
3D Wireframe Modeling

Introduction 3-2
The Locator Design 3-3
Starting Up AutoCAD® 2011 3-4
Using the Startup Options 3-4
Creating the Rectangular Base of the Design 3-6
Create a 3D Box 3-7
Object Snap Toolbar 3-10
Using the Snap Options to Locate the Top Corners 3-10
Using the Copy Option to Create Additional Edges 3-12
Using the TRIM Command 3-14
Using the View Toolbar 3-16
Dynamic Rotation – Free Orbit 3-16
Using the OFFSET Command to Create Parallel Edges 3-17
Creating a Circle Above the UCS Sketch Plane 3-19
Completing the Wireframe Model 3-20
Questions 3-22
Exercises 3-23

Chapter 4
UCS, Viewports and Wireframe Modeling

Introduction 4-2
The V-Block Design 4-2
Starting Up AutoCAD® 2011 4-3
Layers Setup 4-4
Creating the Rectangular Base of the Design 4-5
Creating a Wireframe Box 4-6
Using the View and the UCS Toolbars 4-7
Creating Construction Lines in the Front View 4-8
Copying in the Negative Z Direction 4-10
Creating an Inclined Line at the Base of the Model 4-11
Chapter 5
3D Surface Modeling

Introduction 5-2
Starting Up AutoCAD® 2011 5-4
Using the UCS Toolbars and the Meshes Commands 5-5
Creating a Surface Using the 2D SOLID Command 5-5
Using the Visual Styles Toolbar 5-8
Creating a Surface Using the 3D FACE Command 5-10
The ViewCube 5-12
Creating a Surface of Irregular Shape 5-14
Using the Invisible Edge Option 5-16
Moving with the Grip Editing Tools 5-17
The Locator Wireframe Model 5-18
Moving Objects to a Different Layer 5-18
Advanced Surface Modeling Commands 5-20
Using the Tabulated Surface Option 5-23
Using the Ruled Surface Option 5-24
Questions 5-27
Exercises 5-28

Chapter 6
Solid Modeling - Constructive Solid Geometry

Introduction 6-2
The Guide-Block Design 6-2
Constructive Solid Geometry Concept 6-3
Binary Tree 6-4
The Guide-Block CSG Binary Tree 6-5
Starting Up AutoCAD® 2011 6-6
Layers Setup 6-7
Creating the First 3D object 6-7
Creating the Second Solid Feature 6-9
Boolean Operation - UNION 6-10
Creating the Second Cylinder Feature 6-11
Boolean Operation - SUBTRACT 6-12
Creating another Solid Feature 6-13
Visual Styles Options 6-14
Creating the Final Feature 6-15
Rotating the Rectangular Block 6-16
Moving the Rectangular Block 6-17
The SteeringWheels 6-18
Questions 6-20
Exercises 6-21

Chapter 7
Regions, Extrude and Solid Modeling

Introduction 7-2
The V-BlockSolid Design 7-2
Starting Up AutoCAD® 2011 7-3
Layers Setup 7-4
Setting Up a 2D Sketch 7-5
Defining the Front Edges of the Design 7-7
Creating a Region 7-10
Extruding the Created Region 7-11
Creating a 2D Sketch at the Base of the Model 7-13
Creating a Copy of the 2D Sketch 7-14
Creating the Cutter Solids 7-15
Boolean Operation - Subtract 7-16
Mass Properties of the Solid Model 7-17
Align the UCS to the Inclined Face 7-18
Creating the V-Cut 7-19
Questions 7-22
Exercises 7-23

Chapter 8
Multiview Drawings from 3D Models

Introduction 8-2
The V-Block Design 8-2
Starting Up AutoCAD® 2011 8-3
AutoCAD Paper Space 8-4
Deleting the Displayed Viewport 8-5
Adding Borders and Title Block in the Layout 8-6
Setting Up Viewports inside the Title Block 8-7
Setting Up the Standard Views 8-8
Determining the Necessary 2D Views 8-10
Establishing an Auxiliary View in Model Mode 8-11
Adding a Viewport for an Auxiliary View 8-13
Using the DVIEW Command 8-16
Adjusting the Viewport Scale 8-17
Locking the Base View 8-18
Aligning the 2D Views 8-18
Creating 2D Projected Entities - SOLPROF 8-21
Chapter 9
Symmetrical Features in Designs

Introduction 9-2
A Revolved Design: PULLEY 9-2
Modeling Strategy - A Revolved Design 9-3
Starting Up AutoCAD\textsuperscript{®} 2011 9-4
Layers Setup 9-5
Setting Up a 2D Sketch for the Revolved Feature 9-6
Perform 2D Boolean Operations 9-8
Creating the Revolved Feature 9-12
Mirroring Part 9-13
Combining Parts 9-14
3D Array 9-15
Position and Perform the Cut 9-18
Questions 9-20
Exercises 9-21

Chapter 10
Advanced Modeling Tools & Techniques

Introduction 10-2
A Thin-walled Design: OIL SINK 10-2
Modeling Strategy 10-3
Starting Up AutoCAD\textsuperscript{®} 2011 10-4
Layers Setup 10-5
The First Extruded Feature 10-6
Create an Offset Geometry from an Extracted Surface 10-8
Extrude with Draft Angle 10-10
Aligning the Parts 10-11
Create another Extracted Surface 10-12
Combining Parts – Boolean UNION 10-15
Creating 3D Rounds and Fillets 10-16
Creating a Shell Feature 10-18
Creating a Rectangular Array Cut Feature 10-19
Creating another Rectangular Array Cut Feature 10-21
Making a Design Change 10-23
Grip Editing Approach 10-23
Dynamic UCS Approach 10-25
Questions 10-27
Exercises 10-28
Chapter 11

**Conceptual Design Tools & Techniques**

Introduction 11-2
A Bird House Design 11-3
Starting Up AutoCAD® 2011 11-4
Layers Setup 11-5
The Base Plate 11-6
Create the 1st Floor Inside Compartments 11-7
Create a Solid Feature Using the Press/Pull Command 11-8
Using the Press/Pull Command as an Editing Tool 11-10
Create another Cut Feature 11-11
Adjusting the Compartments 11-13
Adding Additional Compartments 11-14
Creating the Doors 11-15
Creating the 2nd Floor 11-16
Repositioning the 2nd Floor 11-18
Modeling the Roof Section with the Press/Pull Command 11-19
Using the Imprint Command 11-21
Questions 11-24
Exercises 11-25

Chapter 12

**Introduction to Photorealistic Rendering**

Introduction 12-2
Starting Up AutoCAD® 2011 and retrieve the Pulley design 12-3
Environment Setup 12-4
Using the Render command 12-7
Available Lighting Simulation Modes in AutoCAD 12-8
Using the Materials Options 12-9
Activate the Sun & Sky Background option 12-11
Adding Additional Walls 12-14
Creating a Point Light 12-17
Changing the Applied Materials 12-19
Creating a Spotlight 12-20
Removing a Light 12-22
Creating a Distant Light 12-23
Creating New Materials 12-26
Saving the Rendered Images 12-29
Conclusion 12-30
Questions 12-31

Index
Chapter 5
3D Surface Modeling

Learning Objectives

♦ Create 3D Surface Models
♦ Understand and Apply the Different Surface Modeling Techniques
♦ Understand the Use of the 2D SOLID Command
♦ Understand the Use of 3D FACE Command
♦ Use the Hidden Edge Option
Introduction

As illustrated in the previous chapters, there are no surfaces in a wireframe model; it consists only of points, lines, and curves that describe the edges of the object. Surface modeling was developed to provide the surface information that is missing in wireframe modeling. Essentially, defining the skin of a design creates a surface model. Although it is possible to create a surface model without using a wireframe model, in most cases it is much easier to create a surface model on top of a wireframe model. In surface modeling, a wireframe model can be used to provide information about the edges and corners so that the desired faces can be easily positioned and placed.

Surface modeling is more sophisticated than wireframe modeling in that surface modelers define not only the edges of 3D objects, but also the surfaces. Surface modeling provides hiding, shading, and rendering capabilities that are not available in wireframe modeling. Surface models do not provide the physical properties that solid models provide, such as mass, weight, center of gravity, and so on.

The AutoCAD surface modeler defines faceted surfaces using a filled polygon. The created faces of surface models are only planar, which means the surface models can only have approximate curved surfaces. It is important to note that the AutoCAD surface modeler does not create true curved surfaces. To differentiate these two types of surfaces, faceted surfaces are called meshes in AutoCAD. Because of the use of faceted approximation on true curved surfaces, the computer requirements of most faceted surface modelers are typically much less than that of solid modelers. Faceted surface modeling usually provides reasonably good representations of 3D designs with fast rendering and shading capabilities. Faceted surface models are also useful for creating geometry with unusual surface patterns, such as a 3D topographical model of mountainous terrain.

AutoCAD® 2011 provides three basic methods for creating surfaces – the 2D Solid, 3D Face and Region commands. The three commands were developed parallel to the historical development of the different types of computer modelers.

- **2D Solid**: The first generation surface command available in AutoCAD. Used mostly to fill an area in the sketch plane of the current UCS. This type of surface is not a true 3D surface.

- **3D Face**: Creates a true 3D planar surface (allowing X, Y and Z coordinates) of three-sided or four-sided shape. This is the type of surface developed primarily for creating faceted surface models.

- **Region**: Creates a 2D surface of arbitrary shape from existing 2D entities. This command creates the most flexible and the most complicated type of surface available in AutoCAD. This command was developed to allow manipulation of 2D surfaces using one of the solid modeling construction techniques, namely, the Constructive Solid Geometry method.
Although all three commands can be used to create planar surfaces, the resulting surfaces are not equal. In fact, the three commands are developed for specific tasks in mind. The **2D Solid** command is mostly used in 2D drawings to create 2D filled area and the **Region** command is designed so that general 2D shapes can be easily transformed into solid models. The **3D Face** command is the only one that is designed specifically for surface modeling and therefore it is the most suitable for such tasks. The use of the **2D Solid** and **Region** commands in 3D surface modeling can be somewhat awkward and at times very difficult. Note that the use of the **Region** command will be focused on in the solid modeling chapters of this text.

As one can imagine, sketching each surface manually can be very time consuming and tedious. AutoCAD also provides additional tools for more advanced surface modeling, such as **Tabulated surfaces**, **Ruled surfaces** and **Revolved surfaces**. These tools are basically automated procedures, which can be used to define and create multiple copies of planar surfaces in specific directions. The principles and concepts used by these tools are also used in creating solid models, which are covered in chapter six through chapter eight of this text. You are encouraged to re-examine these commands after you have finished the solid modeling chapters.

In this chapter, the general procedures to create surface models are illustrated. The use of the **2D Solid** and **3D Face** commands are illustrated and differences discussed. We will also demonstrate the use of the more advanced surface modeling tools. Two wireframe models, which were created in the previous chapters, will be converted into surface models.
Starting Up AutoCAD® 2011

1. Select the **AutoCAD 2011** option on the *Program* menu or select the **AutoCAD 2011** icon on the *Desktop*.

2. In the *AutoCAD Today Startup* dialog box, select the **Open a Drawing** icon with a single click of the left-mouse-button.

3. Click on the *V-block.dwg* filename to open the *V-block* wireframe model that was created in the previous chapter. (Use the **Browse** option to locate the file if it is not displayed.)

- The *V-block* wireframe model is retrieved and displayed in the graphics window.
The UCS Toolbar and the Meshes Commands

1. In the Menu Bar, select [Tools] → [Toolbars] → [AutoCAD].

2. Select UCS, with the left-mouse-button, to display the UCS toolbar on the screen.
   - The options available in the UCS toolbar allow us to quickly orient and align the UCS.

3. Click on the Mesh tab to show the meshes commands available in AutoCAD.
   - Note that a variety of 2D mesh modeling commands are available to create meshes. On your own, move the cursor on top of the different commands and read the brief description of the commands.

Creating a Mesh Surface Using the 2D Solid Command

- The first generation surface command available in AutoCAD was the 2D Solid command. In AutoCAD 2011, this command can only be accessed through the command prompt area, which is an indication that this command is slowly being phased out. The 2D Solid command is used to fill an area in the sketch plane of the current UCS. It is therefore necessary to properly orient the UCS prior to using the 2D Solid command.

1. Select the 3 Point UCS icon in the UCS toolbar.
   - The 3 Point UCS option allows us to specify the new X-axis and Y-axis directions to align the UCS.

2. In the command prompt area, the message “Specify new origin point<0,0,0>:” is displayed. Pick the lower right corner of the front face of the wireframe model as shown.
3. In the command prompt area, the message “Specify point on positive portion of X-axis:” is displayed. Pick the adjacent corner toward the right side of the model as shown.

4. In the command prompt area, the message “Specify point on positive portion of X-axis:” is displayed. Pick the right corner of the inclined plane as shown.

- The new UCS is aligned to the vertical inclined plane as shown.

5. In the command prompt area, enter Solid to activate the 2D Solid command as shown.

6. Place the first corner point of the 2D solid at the origin of the new UCS.
7. In the command prompt area, the message “Specify second point:” is displayed. Pick the bottom right corner of the inclined plane as shown.

8. In the command prompt area, the message “Specify third point:” is displayed. Pick the corner directly above the origin of the UCS as shown.

- The 2D Solid command requires the third point to be specified diagonally opposite to the second point. This seemingly strange way of specifying the third corner was established when the 2D Solid command was first introduced back in the mid-1980s. Note that the 3D Face command, the second-generation surface command in AutoCAD, does not follow this convention.

9. In the command prompt area, the message “Specify fourth point or [Exit]:” is displayed. Pick the corner directly above the second point we selected as shown in the figure.

10. Inside the graphics window, right-mouse-click once to end the 2D Solid command.

- The 2D Solid command allows the creation of three-sided or four-sided filled polygons, which can be used to represent faces of surface models. Note that in the above steps, we could accept the three-sided polygon after defining the third corner.
Using the Visual Styles Toolbar

1. Move the cursor to the View toolbar panel and left-click on the downward triangle to display a list of available options.

- **2D Wireframe**: Displays the objects using lines and curves to represent the boundaries of objects created. Linetypes and linewidths are visible with this option. Note that this is the default AutoCAD display mode.

- **Conceptual Visual Style**: Creates a shaded image of polygon faces and solids that uses the Gooch face style, a transition between cool and warm colors rather than dark to light. The effect is less realistic, but it can make the details of the model easier to see.

- **Hidden**: Displays the objects using the 3D wireframe representation with lines that are located behind surfaces and solids removed.

- **Realistic Visual Style**: Creates a Gouraud-shaded image of polygon faces and solids that gives the objects a smooth and realistic appearance.

- **Shaded Style**: Shades the objects between the polygon faces. The objects appear flatter and less smooth than Gouraud-shaded objects.

- **3D Wireframe**: Displays the objects using lines and curves to represent the boundaries of objects created. Displays a shaded 3D user coordinate system (UCS) icon. Note that linetypes and linewidths are not visible with this option.

Note that ten different Visual Styles are available; descriptions of the six more commonly used styles are as follows:
2. Click on the **Realistic Visual Style** icon to display the shaded image of the model.

- There exists only one surface in our model. The surface was created with the **2D Solid** command.

3. Select **Free Orbit** in the **View** toolbar as shown.

4. Inside the *arcball*, press down the left-mouse-button and drag it to rotate the model freely in 3D space. Observe the display of the shaded surface in contrast to the 3D wireframe edges that are located behind it.

5. In the **UCS** toolbar, select the **World UCS**. This option resets the UCS to align to the world coordinate system.

6. On your own, reset the display to the **SE Isometric View** before continuing to the next section.
Creating a Mesh Surface Using the 3D Face Command

- The second generation of surface command made available in AutoCAD was the **3D Face** command. The 3D Face command can be used to create true 3D planar surfaces by allowing the X, Y and Z coordinates of the corners to be selected independently of the current UCS. The created polygon can be a three-sided or four-sided shape. This command is the primary construction tool for surface modeling in AutoCAD.

1. In the *Menu Bar*, select [Draw] → [Modeling] → [Meshes] → [3D Face].

2. In the command prompt area, the message “3dface Specify first point or [invisible].” is displayed. Pick the lower right corner of the vertical inclined face of the model as shown.

3. In the command prompt area, the message “Specify second point or [invisible]:” is displayed. Pick the adjacent corner above the previous selected corner of the vertical inclined face as shown.

4. In the command prompt area, the message “Specify third point or [invisible]:” is displayed. Pick the adjacent corner of the right vertical face of the model as shown.
5. In the command prompt area, the message “Specify fourth point or [invisible] <Create three-sided face>.” is displayed. Pick the corner below the last selected corner as shown.

6. In the command prompt area, the message “Specify third point or [invisible] <exit>.” is displayed. Pick the back corner of the model as shown.

7. In the command prompt area, the message “Specify fourth point or [invisible] <Create three-sided face>.” is displayed. Pick the back corner of the model as shown.

- Note that this surface is created independent of the UCS and two corners of the previous face were used to position this face.

8. Inside the graphics window, right-mouse-click to activate the option menu and select **Enter** with the left-mouse-button to end the 3D Face command.
The ViewCube

The ViewCube is a 3D navigation tool that appears when the 3D graphics system is enabled. With the ViewCube, you can switch between standard and isometric views.

Once the ViewCube is displayed, it is shown in one of the corners of the graphics window over the model in an inactive state. The ViewCube also provides visual feedback about the current viewpoint of the model as view changes occur. When the cursor is positioned over the ViewCube, it becomes active and allows you to switch to one of the available preset views, roll the current view, or change to the Home view of the model.

1. Move the cursor over the ViewCube and noticed the different sides of the ViewCube become highlighted and can be activated.

2. Single left-mouse-click when the Front side is activated as shown. The current view is set to viewing the Front side.

3. Move the cursor over the counterclockwise arrow of the ViewCube and notice the Orbit option becomes highlighted.

4. Single left-mouse-click to activate the counterclockwise option as shown. The current view is orbited 90 degrees; we are still viewing the Front side.

5. Move the cursor over the Left arrow of the ViewCube and notice the Orbit option becomes highlighted.

6. Single left-mouse-click to activate the Left arrow option as shown. The current view is now set to viewing the Top side.
7. Move the cursor over the top edge of the ViewCube and notice the roll option becomes highlighted.

8. Single left-mouse-click to activate the Roll option as shown. The view will be adjusted to roll 45 degrees.

9. Move the cursor over the ViewCube and drag with the left-mouse-button to activate the Free Rotation option.

10. Move the cursor over the Home icon of the ViewCube and notice the Home View option becomes highlighted.

11. Single left-mouse-click to activate the Home View option as shown. The view will be adjusted back to the default SW Isometric view.

12. In the Visual Styles toolbar, click on the Hidden icon to display the model with hidden lines removed.

13. On your own, use the ViewCube to rotate the model and examine the constructed surface model.
Creating a Surface of Irregular Shape

- The **3D Face** command allows us to create three-sided or four-sided polygons. For surfaces of irregular shape, the **Invisible Edge** option is available in conjunction with the **3D Face** command. Note that the **Invisible Edge** option cannot be applied to polygons created by the **2D Solid** command.

1. Select the **2D Wireframe** in the **Visual Styles** toolbar.

- The **2D Wireframe** command resets the display to the default AutoCAD display mode. Note that this step is required for the **Invisible Edge** option to work correctly.

2. In the command prompt area, enter `3dface` to activate the command as shown.

3. In the command prompt area, the message “_3dface Specify first point or [invisible]:” is displayed. Pick the top right corner of the model as shown.

4. In the command prompt area, the message “Specify second point or [invisible]:” is displayed. Pick the top front corner of the model as shown.

5. In the command prompt area, the message “Specify third point or [invisible] <exit>:” is displayed. Pick the top corner of the model adjacent to the previously selected corner as shown.
6. In the command prompt area, the message “Specify fourth point or [invisible] <Create three-sided face>.” is displayed. Pick the corner below the last selected corner as shown.

7. On your own, repeat the zigzagging pattern to define polygons until all corners of the inclined surface have been selected and additional polygons are created as shown in the figure. Note that the last polygon we created is a three-sided polygon.

8. In the Visual Styles toolbar, click on the Hidden icon to display the model with hidden lines removed. Note that the edges of the polygons are displayed as shown.

9. On your own, examine the model by selecting the different Visual Styles.

10. Rest the Visual Styles toolbar to 2D Wireframe, the default AutoCAD display mode.
Using the Invisible Edge Option

- The Invisible Edge option is used to turn off the display of selected edges and therefore allow the adjacent polygons, created by the 3D Face command, to appear as being joined together.

1. In the command prompt area, enter `Edge` to activate the command as shown.

2. In the command prompt area, the message “Specify edge of 3dface to toggle visibility or [Display]:” is displayed. Pick the three edges inside the inclined surface as shown.

3. Inside the graphics window, right-mouse-click to activate the option menu and select `Enter` to end the `Edge` command.

4. Set the Visual Style toolbar to `Hidden`.

5. On your own, examine the model by selecting the different `Visual Styles`.

- The selected edges are removed from the display so that the face of the inclined surface of the model appears to be more realistic.
Moving with the Grip Editing Tools

1. Select one of the 3D faces we created by clicking on the front edge of the inclined surface as shown.

- Four grip points, the small rectangles displayed at the corners of the highlighted polygon, can be used to adjust the size and shape of the highlighted polygon.

2. Move the cursor on one of the grip points. Notice the grip editing axes is automatically aligned to the grip point.

3. Click on one of the axes and drag with the left-mouse-button to move the grip point. (Clicking on the axis constrain the movement to the selected axis.)

4. Press the [Esc] key to deselect the highlighted entities.

➢ On your own, repeat the above steps and complete the surface model of the design.
The *Locator* Wireframe Model

1. Click on the **Open** icon in the **Standard** toolbar.

2. In the **Select File** window, pick the **Locator** file that was created in Chapter 3.

3. Click **Open** to open the model file.

Moving Objects to a Different Layer

Prior to create additional surfaces, we will first organize the existing geometry that has been constructed.

1. Click **Layers Properties Manager** in the **Layers** toolbar.
2. Click on the **New** button to create new layers.

3. Create **three new layers** with the following settings:

<table>
<thead>
<tr>
<th>Layer</th>
<th>Color</th>
<th>Linetype</th>
<th>Lineweight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Construction</td>
<td>White</td>
<td>Continuous</td>
<td>Default</td>
</tr>
<tr>
<td>Wireframe</td>
<td>Blue</td>
<td>Continuous</td>
<td>0.30mm</td>
</tr>
<tr>
<td>Surface</td>
<td>Cyan</td>
<td>Continuous</td>
<td>Default</td>
</tr>
</tbody>
</table>

4. Click on the **Close** button to accept the settings and exit the *Layer Properties Manager* dialog box.

5. Inside the graphics window, pre-select all entities by using the left-mouse-button to create a *selection window* enclosing all entities.
   - Note that all selected entities are highlighted.

6. On the *Object Properties* toolbar, choose the **Layer Control** box with the left-mouse-button.
   - Notice the layer name displayed in the *Layer Control* box is the selected object's assigned layer and layer properties.

7. In the *Layer Control* box, click on the **Wireframe** layer name as shown.
   - All entities of the *Locator* model are moved to the *Wireframe* layer.

8. Press the **[Esc]** key twice to deselect all highlighted entities.
Advanced Meshed Surface Modeling Commands

Several of the advanced surface-modeling commands are displayed in the last group of the Meshed Surface Modeling toolbar. These commands allow us to quickly create and duplicate surfaces in specific manners.

- **Revolved Surface**: Creates a surface mesh by rotating a group of objects about an axis.

- **Tabulated Surface**: Creates a surface mesh representing a general tabulated surface defined by a path curve and a direction vector. The resulting mesh is a series of parallel polygons running along a specified path.

- **Ruled Surface**: Creates a surface mesh between two objects.

- **Edge Surface**: Creates a surface patch mesh from four edges.

**SurfTab1 & SurfTab2 system variables**: These two variables are used to set the number of increments used by the Ruled Surface and Tabulated Surface commands. The default values are set to six, which means any curve will be approximated with six straight lines.

1. On your own, use the **Free Orbit** command and adjust the display of the wireframe model so that the four vertical lines connecting the two circles are visible as shown.

- To illustrate the use of the Ruled Surface and Tabulated Surface commands, we will first split the top circle into two arcs. Note that these surfacing commands allow us to construct a polygon mesh for different situations and regions. The split of the circle is necessary in creating a mapped surface on the top plane of the model.
2. Select **Break** in the **Modify** toolbar.

- The **Break** command can be used to erase parts of objects or split an object in two. Note that we can only erase parts of a circle. We will therefore erase a portion of the circle and then split the circle into two arcs.

3. Select the top circle as shown. Note that the portion defined by two points will be erased.

- By default, AutoCAD treats the selection point as the first break point. We can override the first point by choosing **First point** in the option menu.

4. In the command prompt area, the message “**Specific second break point or [First point]**” is displayed. Right-mouse-click once and select **First point** in the option menu.

5. In the command prompt area, the message “**Specific first break point:**” is displayed. Choose the top endpoint of the vertical line as shown.

6. In the command prompt area, the message “**Specific second break point:**” is displayed. Choose the top endpoint of the vertical line as shown.

- One quarter of the circle has been erased. We will next split the arc into two arcs, again using the **Break** command.
7. Select **Break** in the **Modify** toolbar.

8. Select the top arc as shown.
   - By default, AutoCAD treats the selection point as the first break point. We can override the first point by choosing **First point** in the option menu.

9. In the command prompt area, the message “**Specific second break point or [First point]:**” is displayed. Right-mouse-click once and select **First point** in the option menu.

10. In the command prompt area, the message “**Specific first break point:**” is displayed. Choose the top endpoint of the left vertical line as shown.

11. In the command prompt area, the message “**Specific second break point:**” is displayed. To split an object, choose the **same endpoint** that was chosen as the first endpoint.

12. Select **Extend** in the **Modify** toolbar. Notice the **Projection** type is set to **View**, as shown in the prompt window.

13. Select the right vertical edge to be the extending boundary as shown.

14. Inside the graphics window, right-mouse-click once to accept the selection.

15. Pick the shorter arc near the right endpoint to extend the arc in that direction.

16. Inside the graphics window, right-mouse-click once to display the option menu and select **Enter** to end the **Extend** command.
Using the Tabulated Surface Option

- In AutoCAD, the **TABSURF** command allows us to construct a polygon mesh representing a general tabulated surface defined by a path curve and a direction vector.

1. Set the **Surface** layer as the **Current Layer** by choosing the layer name in the **Layer Control** box as shown.

- We will place the surface model on a different layer than the wireframe model.

2. Click **Tabulated Surface** in the **Primitives** toolbar.

3. In the command prompt area, the message “Select object for path curve:” is displayed. Choose the upper arc as shown.

4. In the command prompt area, the message “Select object for direction vector:” is displayed. Choose the vertical line near the top endpoint as shown. Note that the endpoint of the line is used as a reference point to determine the direction of the polygon mesh.

5. On your own, use the **Orbit** and **Visual Styles** commands to examine the constructed polygons.
Exactly six polygons are created and positioned along the selected *path curve*, the upper arc, with the *Tabulated Surface* command. This is set by the *SurfTab1* variable. We can adjust number of segments to use by typing the word, *surftab1*, at the command prompt.

Note that a surface modeler using polygons to approximate true curves is called a *faceted surface modeler*.

**Using the Ruled Surface Option**

In AutoCAD, the **RULESURF** command allows us to construct a polygon mesh between two objects. We can use two different objects to define the edges of the ruled surface: lines, points, arcs, circles, ellipses, elliptical arcs, polylines, or splines. The two objects to be used as the *rails* of a ruled surface mesh must both be either open or closed. For open curves, AutoCAD starts construction of the ruled surface based on the locations of the specified points on the curves.

1. Pick **Ruled Surface** in the *Draw* pull-down menu.

2. In the command prompt area, the message “*Select first defining curve:*” is displayed. Choose the lower arc by clicking on the right side as shown.

3. In the command prompt area, the message “*Select second defining curve:*” is displayed. Choose the inside straight edge on the right side as shown.
4. In the Visual Styles toolbar, click on the Hidden icon to display the model with hidden lines removed.

- The selected edges are removed from the display so that the face of the ruled surface appears to be more realistic.

5. On your own, repeat the above steps and create another ruled surface as shown. (Hint: Use the Realtime Zoom function to assist the selection of the arc.)
6. In the command prompt area, enter `3dface` to activate the **3D Face** command as shown.

- On your own, complete the surface model as shown. (Hint: Use the **Edge** command to hide the edges of the created faces.)
Questions:

1. List and describe three differences between *Wireframe models* and *Surface models*?

2. List and describe the three types of surfaces available in AutoCAD.

3. List and describe two different shading options in AutoCAD.

4. What is the difference between the *2D Solid* and *3D Face* commands in AutoCAD?

5. What is the difference between *Tabulated Surface* and *Ruled Surface* in AutoCAD?

6. Identify and describe the following commands:

   a) ![Image](image1)

   b) ![Image](image2)

   c) ![Image](image3)
Exercises: All dimensions are in inches.

1.

2.
3.

4.
NOTES: